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Introduction
Kaboom! Factory is a Windows 3.1 sound file editor which allows you to play, record, and edit digitized 
sound files.    Digitized sounds are data files stored on your computer's hard drive which are recorded 
through a sound card and a microphone.

Kaboom! Factory has been designed to be extremely easy to use while still allowing for complex sound 
editing operations.    Although some sound editors limit you to editing only files which can fit in memory, 
Kaboom! Factory edits all files on the hard drive.    This allows you to open multiple sound files for 
playback and editing at one time.    You are only limited by the amount of space on your hard drive.



Setting Magnification
The vertical scroll bar on each data window allows you to change the magnification of the sample shown 
in the data window. The current magnification setting is displayed in the last window of the upper status 
bar.

The magnification defines how many samples of sound data are "squeezed" into each point on the 
screen.    The setting is shown as a value of 1:XX    where XX is the number of samples represented by 
each point on the screen. For example if the setting is 1:1 then each point on the screen is one sample.    
If the setting is 1:256 then there are 256 samples represented by each point on the screen.



Identifying an Unknown Sound Format
Kaboom! Factory loads WAV, SND, AIFF, and VOC sound files and also identifies a variety of other 
formats.

Most sound files contain a data block which identifies the format of the file.    Kaboom! Factory knows 
about many of these formats and can identify them by searching the file for this block.    If Kaboom! 
Factory recognizes the format of the file it will display the file type along with a variety of other 
information on the file at the bottom of the Open dialog box.    The information includes, File type, 
data format, Bits per sample and mono/stereo, sample rate, length of the file in samples and time, and the
number of stored data bytes.



Editing a File
When you start Kaboom! Factory no data windows are open.    At this point you can load a sample file, 
record a new sample, or create a new sample window.    If sample data is too large to fit in a data window 
you can use the scroll bar at the bottom to move the data within the window.

When you want to change the sample data you must first select the section you want to modify.    To 
select a section of data hold down the left mouse button within the data window and then move the 
mouse either left or right selecting a section of data.    To end the selection release the left mouse button.

Once you have selected a section of the sample it will appear in an inverse color.    You may now delete it,
copy it for insertion in a new area of the sample, or for adding or mixing to another sample.    You may 
also perform a variety of effects on sample selections.

Info!
When editing stereo files selecting in the upper 1/4 of the wave window will select the left channel, 
selecting in the lower 1/4 of the wave window will select the right channel, and selecting within the middle 
1/2 will select both channels.    This allows you to perform effects functions on a single channel within a 
stereo file.

Once a selection is made you can toggle the selection between left, right, and both by using the TAB key.



Extending a Selection
After selecting a section of the data window you will sometimes find that the starting or ending point is not 
quite what you wanted.    You could just reselect the data but it is often difficult to get the start or end point 
just right. .

Kaboom! Factory allows you to update the selection via the right mouse button.    Once you have selected
an area you can continue to select without losing the previous selection by clicking and dragging with the 
right mouse button.    This is the "Extend Selection" mode.

Which side of the selection is updated depends on where you click the right mouse button.    If you click to
the right of 1/2 the selection length then the selection will drag the right hand side of the selection.    If you 
click to the left of 1/2 the selection length then the selection will drag the left side of the selection.



Drag Mixing and Pasting
Drag Mixing and Pasting allows you to quickly mix or paste data between two data windows.    This allows
you to mix and paste without using the clipboard.

To Drag Mix/Paste:

1 Select a section of data from a window using the left mouse button.

2 Press and hold the left mouse button in the selected area of the data window from which you 
want to mix or paste.    The cursor will change to an arrow dragging a document with a small 
waveform.

3 Drag the cursor over the window in which you want to paste or mix the selected data.

4 Let go of the left mouse button which will bring up the following Dialog box.

5 Press either the Mix or Paste buttons to finish the operation or press Cancel to skip the operation.

Modifiers:
Holding down the shift key while dragging a section will skip the Mix/Paste dialog and perform the 
same operation as the last drag.



Channel Conversions
When converting a file from mono to stereo or stereo to mono via the Data Format dialog you will be 
prompted for the type of conversion you would like to perform.

When performing mono to stereo conversions the following options are available:

Left Channel The mono sample is placed in the left channel. The right channel is set to silence.
Right Channel The mono sample is placed in the right channel. The left channel is set to silence.
Both Channels The mono sample data is copied into both channels of the stereo sample.

When performing stereo to mono conversions the following options are available:

Left Channel Mono sample data is taken from the left channel of the stereo file.
Right Channel Mono sample data is taken from the right channel of the stereo file.
Mix Channels Mono sample data is created by mixing both channels of the stereo file.



Sound Formats
The file formats recognized by Kaboom! Factory are listed below with the extension used to identify them 
to the user.

Creative Labs VOC File (.VOC)
This is one of the most commonly found sample sound formats found on PC compatible computers.    The
VOC format supports packed data which Kaboom! Factory will unpack prior to importing the file.    The 
VOC format also supports information for silence, looping, and varying sample rates.    When Kaboom! 
Factory imports a VOC file it uses the first sample rate found and ignores such info as looping and 
silence.    Kaboom! Factory will save VOC files as unpacked data with none of the additional information 
such as looping or silence.

Macintosh AIFF (.AIF; .SND)
This format is used on the Apple Macintosh to save sound data files.    AIFF files are the best when 
transferring files between the PC and the Mac using a network, since most network software will delete 
any resource info in a Macintosh file.    Kaboom! Factory can also read an AIFF with a Mac binary header 
attached but will identify the file as a Macintosh Resource instead.

Macintosh Resource (.SND)
This format is used on the Apple Macintosh to save sound resources.    When reading a file of this type it 
must have a Mac-Binary header.    This header is attached to binary files transferred with common 
Macintosh file transfer programs.    Kaboom! Factory does not save to this file format.

Microsoft    Wave File (.WAV)
This is a format for sampled sounds defined by Microsoft for use with their Multimedia Extensions for 
Windows.

Sounder/SoundTool File (.SND)
This format is used with the Shareware applications Sounder and Sound Tool.    It is very popular on 
Bulletin Boards and various On-line services.



The Play Bar Status Fields

The play bar above the data window displays magnification ratio, information on the rate at which a file 
was loaded, the number of bits per sample, the number of channels, and the total size of the file.

The first text box on the play bar shows the sample magnification ratio.

The second text box on the play bar shows the sample rate which was stored in the loaded file.

The third text box shows the current bits per sample.

The fourth text box shows whether the file is mono or stereo.

The fifth text box shows the total length of the current sample.

Info!
The play bar values are always displayed for the currently active data window.



The Status Bar

The status bar below the data window displays information on the position of the current insertion point, 
beginning and ending points of the current selection, and the size of the current selection. 
It also shows brief one line help on menu options and the tool bar.

The first text box on the status bar shows the location of the current Insertion Point.

The second text box shows the location of the start of the current selection.

The third text box shows the location of the end of the current selection.

The fourth text box shows the total length of the current selection.

Info!
The status bar values are always displayed for the currently active data window



The Tool Bar

The tool bar gives you a short cut method of using options in the Kaboom! Factory menus.    Clicking on a 
tool bar button will perform an option from the menu associated with it.    The most commonly used 
operations can be found on tool bar.



Short Cut Keys
The following is a comprehensive list of short cut keys available in Kaboom! Factory.

Cursor Movement

Press To move to
Right Arrow The next screen pixel
Left Arrow The previous screen pixel
End The last sample.
Home The first sample.
Page Up 50 pixels past the current cursor
Page Down 50 pixels previous to the current cursor
Control+Right Arrow 10 pixels past the current cursor
Control+Left Arrow 10 pixels previous to the current cursor
Numpad + The next sample
Numpad - The previous sample
Control+Numpad + 10 samples past the current cursor
Control+Numpad - 10 samples previous to the current cursor
Numpad 5 The opposite end of the current selection

Selecting Data

Press To select/cancel from cursor to
Shift+Right Arrow The next screen pixel
Shift+Left Arrow The previous screen pixel
Shift+End The last sample.
Shift+Home The first sample.
Shift+Page Up 50 pixels past the current cursor
Shift+Page Down 50 pixels previous to the current cursor
Shift+Control+Right Arrow 10 pixels past the current cursor
Shift+Control+Left Arrow 10 pixels previous to the current cursor
Shift+Numpad + The next sample
Shift+Numpad - The previous sample
Shift+Control+Numpad + 10 samples past the current cursor
Shift+Control+Numpad - 10 samples previous to the current cursor
Control+Numpad 5 All data
Alt+A
Tab Cycle through stereo selection of left channel, right channel, both channels
Shift+Tab Cycle through stereo selection of left channel, right channel, both channels, in reverse order
Editing Selected Text

Press To
Control+C Make a copy of the selected data and place it in the 
Control+Insert clipboard
Control+X Delete the selected data and place it in the clipboard.
Control+Delete
Delete Delete the selected data, do not place it in the 
Backspace clipboard.
Control+Y Delete all but the selected data.
Shift+Insert Paste data from the clipboard into the active window.
Control+V
Control+M Mix data from the clipboard into the active window.
Control+Z Cancel the previous editing operation.
Control+Backspace
Control+Q Magnify selected section.
Control+W Set magnification to minimum and reset data display at start of data.
Up Arrow Increase Magnification
Down Arrow Decrease Magnification

File Handling and Window Creation

Press To
Control+N Create a new data window.
Shift+Contol+N Create a new data window using previous settings. (No Dialog Box)
Control+O Open a sample data window from a file.
Control+F12
Control+Alt+F2



Control+S Save a sample data window to a file.
Shift+F12
Shift+Alt+F2
Control+A Save a sample data window to a new file or as a 
F12 different format file.
Alt+F2

System and Miscellaneous Commands

Press To
Control+P Play the contents of the current data window.
Control+R Record to a new data window.
Escape Stop the currently playing data window.
Shift+F4 Tile the data windows horizontally.
Shift+F5 Cascade the data windows.
Alt+F4 Exit Kaboom! Factory.



Glossary
Clipboard

The clipboard is where sample data is saved when you cut it from a sample so that you may past it or mix
it into another sample.    Kaboom! Factory maintains it's own clipboard for cutting and pasting sample data
allowing you to keep memory usage to a minimum.    However, this does not change the normal operation 
of the clipboard and you can still cut and paste between Kaboom! Factory and other Windows 
applications.

Insertion Point

The Insertion Point is like the cursor in a word processor.    It is where pasted data will be placed or other 
data may be inserted depending on the operation.    The Insertion Point appears as a vertical flashing 
black line and can be moved by clicking the left mouse button any where in the data window.

Sampled Sound

Sampled sounds are sounds which have been recorded in a digital format and saved on your system for 
playback through a sound board.

SMPTE

The Society of Motion Picture and Television Engineers time code.    This code is used to synchronize 
time between devices.    The time code is calculated in Hours:Minutes:Second:Frames, where Frames are
1/30 of a second.



Nova Development Corp.

Nova Development Corp.
23801 Calabasas Road
Suite 2005
Calabasas, CA 91302-1547

(818) 591 9600
(818) 591 8885 (FAX)

© Copyright 1991-1993 Sonic Foundry.    All rights reserved.    No part of this manual may be copied, 
reproduced, translated or transmitted in any form by any means for any purpose without the express 
written permission of Sonic Foundry.

INFORMATION CONTAINED IN THIS MANUAL IS SUBJECT TO REVISION AND ALTERATION 
WITHOUT NOTICE AND DOES NOT REPRESENT AN OBLIGATION OF ANY SORT ON THE PART OF 
SONIC FOUNDRY.

Kaboom!, Kaboom! Factory, and Nova Development are trademarks of Nova Development Corp.    Sound 
Forge, and Sonic Foundry are trademarks of Sonic Foundry.    Microsoft®, and MS-DOS® are registered 
trademarks and Windows is a trademark of Microsoft Corporation.    IBM®, and PC AT® are registered 
trademarks and Personal System/2 is a trademark of International Business Machines.    All other 
products are trademarks or registered trademarks of their respective owners.



Sonic Foundry

This product is based on the technology of the Sonic Foundry product Sound Forge
Sonic Foundry is the developer of this product and other quality sound tools for Microsoft Windows.

Sonic Foundry
1110 East Gorham
Madison, WI 53703

(608) 256 3133
(608) 256 7300 (FAX)

© Copyright 1991-1993 Sonic Foundry.    All rights reserved.    No part of this manual may be copied, 
reproduced, translated or transmitted in any form by any means for any purpose without the express 
written permission of Sonic Foundry.

INFORMATION CONTAINED IN THIS MANUAL IS SUBJECT TO REVISION AND ALTERATION 
WITHOUT NOTICE AND DOES NOT REPRESENT AN OBLIGATION OF ANY SORT ON THE PART OF 
SONIC FOUNDRY.

Sound Forge, and Sonic Foundry are trademarks of Sonic Foundry.    Microsoft®, and MS-DOS® are 
registered trademarks and Windows is a trademark of Microsoft Corporation.    IBM®, and PC AT® are 
registered trademarks and Personal System/2 is a trademark of International Business Machines.    All 
other products are trademarks or registered trademarks of their respective owners.



The Edit Menu
The edit menu allows you to peform a variety of editing operations on sound files.

Undo
Cut
Copy
Paste
Mix
Delete
Select All
Crop
Clipboard

Info
Play

Data Format



Undo
Use this command to undo the last edit operation.    For instance, if you deleted a section of sample 
by accident, simply choose the Undo option from the edit menu to put the data back.
Shortcut:

Keyboard: Control+Z, Alt+Backspace
Toolbar:    



Cut
Use this command to remove selected sample data and put it on the clipboard.    This command has 
no effect if there is no selected data.

Cutting sample data replaces the previous contents of the    clipboard.
Shortcut:

Keyboard: Control+X, Control+Del
Toolbar:    



Copy
Use this command to copy selected sample data to the clipboard.    This command has no effect if 
there is no selected data.
Shortcut:

Keyboard: Control+C, Control+Insert
Toolbar:    

Copying sample data replaces the previous contents of the clipboard.



Paste
Use this command to insert a copy of the clipboard contents at the current insertion point.    This 
command has no effect if the clipboard is empty.

Pasting data of different sample rates will cause the data in the clipboard to play at the same rate as 
that in the current sample in which the data is pasted.
Shortcut:

Keyboard: Control+V, Shift+Insert
Toolbar:    



Mix
Use this command to mix a copy of the clipboard contents with the sample data at the current 
insertion point.    This command has no effect if the clipboard is empty.

Mixing data of different sample rates will cause the data in the clipboard to play at the same rate as 
that in the current sample with which the data is mixed.
Shortcut:

Keyboard: Control+M
Toolbar:    



Delete
Use this command to remove selected sample data .    This command has no effect if there is no 
selected data.

Deleting sample data does not copy the data to the clipboard.
Shortcut:

Keyboard: Delete



Select All
Use this command to select all data in the current data window.

Shortcut:
Keyboard: Alt+A, Control + Numpad 5
Mouse: Double clicking the left mouse button in a data window will select all data.



Crop
Use this command to remove all data from the sample except the selected section.    This command 
has no effect if there is no selected data.

Cropping sample data does not copy data to the clipboard.
Shortcut:

Keyboard: Control+Y
Toolbar:    



Clipboard >> Info
Use this command to display information on the current contents of the clipboard.    Information 
includes, size, rate, number of channels, and bits per sample.    If no data is in the clipboard you will 
be notified with a message box.



Clipboard >> Play
Use this command to hear the current contents of the clipboard.    This command has no effect if 
there is no data in the clipboard.



Data Format
Use this command to change the data format of the current data window.    This includes rate, bits per 
sample, and stereo/mono.

Dialog Box Options

Sample Size
Check 8 or 16 bit for the sample size.

Channels
Check mono or stereo for the number of channels.

Rate
The rate can be set from 5000 Hz to 48000 Hz by entering the rate you wish to use.    You may 
also select the most common file rates by using the drop down list. 

Info!
Kaboom! Factory will store the last two non-standard rates you enter at the end of the list of standard 
rates.

Shortcut:
You can quickly invoke the data format dialog box by double clicking with the left mouse button on 
any of the three status boxes for rate, channels, and data size in the play bar.    You can also 
individually change the rate, channels, or data size by using the right mouse button on the same 
status boxes to invoke pop up menus.



The File Menu
The file menu allows you to perform various file related commands.

New
Open
Close
Save
Save as
Delete
Temporary Storage
Wave Devices
Exit



New
The New command creates a new sound data window.

Dialog Box Options

Channels
Check the button to select whether the new data will be mono or stereo.

Sample Size
Check the button to select whether the new data will be 8 bit or 16 bit.

Rate
Select a standard sample rate from the drop down list box or type in a custom rate.

Maximum Editing Time
Shows the maximum time currently available for editing a file of the specified type.

Modifiers:
Holding down the shift key while selecting the New menu item will skip the New dialog box and use 
the previously selected Mono/Stereo, 8 bit/16 bit, and Rate settings.

Shortcut:
Keyboard: Control+N

Toolbar:    



Open
Use this command to load a sound file from disk into Kaboom! Factory.

Dialog Box Options

File Name
Type the file name you want to open or a *. and an extension to see a list of files with the 
corresponding extension in the current directory.

Files
Lists the files in the current directory of the type specified in the File Name box.

Drives
Lists available drives.    Select a new drive from this combo box.

Directories
Lists available directories.    Select a new directory from this list box.

File Types
Select the type of file you want to open.

Shortcut:
Keyboard: Control+O, Control+F12
Toolbar:    



Close
Use this command to close the current sample data window.    If the data has not been saved 
since the last edit you will be asked if you wish to save your changes.



Save
Use this command to save the current sample data.    If the data is new data which was not retrieved 
from a specific file or was loaded from a format which is not supported for saving you will be prompted
with the Save As dialog box.
Shortcut:

Keyboard: Control+S, Shift+F12
Toolbar:    



Save as
Use this command to save the current sample data in a different file name and/or file format.

Dialog Box Options

File Name
Type the name of the file in which you want to save the current sample.

Drives
Lists available drives.    Select a new drive from this combo box.

Directories
Lists available directories and drives.    Select a new directory or drive from this list box.

File Types
Select the type of file to which you would like to save.

Data Format
Shows the format in which the data will be saved.    Select a new data format from this drop down 
list box.

Info!
Only data formats supported by the selected File Type are listed in the Data Format drop down list 
box.

Shortcut:
Keyboard: Control+A, F12



Delete
Use this command to delete a sound file from your hard drive.

Dialog Box Options

File Name
Type the file name you want to delete or a *. and an extension to see a list of files with the 
corresponding extension in the current directory.

Files
Lists the files in the current directory of the type specified in the File Name box.

Drives
Lists available drives.    Select a new drive from this combo box.

Directories
Lists available directories.    Select a new directory from this list box.

File Types
Select the type of file you want to delete.    This provides an easy way of setting the file extension.



Preferences >> Temporary Storage
Use this command to specify where the Kaboom! Factory temporary files will be stored and how big 
your undo files are allowed to be.

Kaboom! Factory stores its temporary working data in a temporary directory on your hard drive or 
RAM drive.    Factory will run faster if you specify your RAM drive as the home for its temporary files.   
Using a temporary file space allows you to edit very large files and keeps Kaboom! Factory from 
eating up large portions of RAM on your computer.    Your temporary directory must have enough 
space to handle the total size of all files you plan to edit at one time along with space for any 
clipboard data and undo buffers.    

The Undo buffers are also stored in the temporary directory.    You can specify the maximum amount 
of data that can be placed in each undo file by setting the Undo Buffer Size.

If you change the Temporary Directory you will have to close Kaboom! Factory for the change to take 
effect.    Changing the Undo Buffer Size is immediate.



Preferences >> Wave Devices 
Use this command to specify what wave devices Kaboom! Factory should use for recording and 
playback.    Note that the capabilities of these devices may limit you from playing some files.

Dialog Box Options

Output
Select the device to be used when playing sound data.

Input
Select the device to be used when recording sound data.

Selecting a mapper device such as the Wave Mapper or Sound Mapper allows Windows to select
an appropriate device to use for the current sound data.

Buffer Alignment
Select the alignment of data buffer blocks passed to the wave driver.    This field should normally 
be set to 32, but some drivers may be optimized to use smaller blocks. 

Memory Buffer Size
Select the amount of RAM you would like to use for pre-buffering sounds during play and record.   
Using a large value can optimize performance at high sample rates but may also cause a slight 
delay on play back.

Preload All
Setting the Preload All option on will cause Kaboom! Factory to load all it's buffer memory before 
starting the play operation.    Turning this option on can improve performance.

 When using the PC Speaker as a wave output device, the wave alignment should be set at 2kb and 
the Buffer Size should be set to 4k.    Using large values for the PC Speaker will hinder performance.



Exit
Use this command to exit Kaboom! Factory.    You will be asked whether you would like to save any 
samples you have modified during the editing session.
Shortcut:
Keyboard: Alt+F4



The View Menu
The view menu allows you to configure how Kaboom! Factory displays its information to you.

Display
Status
Zoom Selection
Zoom Out
Status Format
Tool Bar
Ruler



Display
Use this command to set your display preferences.    These include, draw resolution, maximum zoom 
on load,and grid lines.

Dialog Box Options

Resolution
Sets the resolution which Kaboom! Factory uses to draw the sample data.    The higher the 
resolution the more accurate the representation of the sample but the longer it takes to draw the 
sample.

High High sample detail, takes the longest to draw, best for fast machines.
Medium Medium sample detail, medium draw, best for intermediate machines.
Low Low sample detail, fast draw, best for slower machines.

Grid Lines
Specifies whether the sample data window displays a set of grid lines indicating the volume of the
sample.    Grid lines are drawn at volume levels of 0, 1/2 the maximum volume and at the 
maximum volume.

Max Zoom on Load
Specifies the maximum zoom magnification when loading a new sample file.    This allows you to 
control the maximum data that should be shown in a data window when a file is loaded from the 
hard drive.



Status
Use this command to set your status preferences.    These include, SMPTE type, Frames per second 
value, and updating of the play counter.

Dialog Box Options

SMPTE Format
Sets the SMPTE type used when displaying SMPTE values in the status bars.

SMPTE 30 FPS Calculates status values using a 30 Frames per second SMPTE code.

Drop 29.97 FPS Calculates status values using a 29.97 frames per second SMPTE code. 
This is accomplished by dropping two frames every minutes except for 
minutes 00,10,20,30,40, and 50.

Nondrop 29.97 FPS Calculates status values using a 29.97 frames per second SMPTE code. 
Frame counting does not drop frames so no frame compensations are 
necessary for dropped frames.

EBU 25 FPS Calculates status values using a 25 Frames per second SMPTE code.    
This format is the European Broadcast Union time code.

Film Sync 24 FPS Calculates status values using a 24 Frames per second SMPTE code.    
This format is for standard 24 frames/second film media.

Frames Per Second
Specifies the frame rate used to calculate frame values.

Frame values are useful when trying to synchronize sound with animation.    Most animation 
players specify a playback frame rate at which video frames are shown to the user.    If you are 
using an animation that has a frame rate of 15.0 frames per second, you would set the Frame 
rate to 15.0.    When status values are shown by Factory they will be shown in values of frames.    
This allows you to find the frame to which a given point in the sound file corresponds.

Frame rates can be any value between 1.0 and 1000.0 frames per second.

Enable Play Counter
Specifies whether Factory will show a running play counter during play back.    A running play 



counter may affect performance on slower computers.

Enable Record Counter
Specifies whether Factory will show a running record length on the play bar during record.    A 
running record length may affect performance on slower computers.



Tool Bar
Use this command to hide or show the tool bar.

The tool bar allows you to access common commands through buttons.



Ruler
Use this command to hide or show the ruler.

The ruler is the small section at the top of each data window which displays the current positions of 
sample data.



Zoom Selection
Use this command to maximize a selected area in the data window.

The Zoom Selection command will calculate the maximum zoom factor for the size of a selection 
area, redraw the data at this zoom factor, and left justify the data in the data window.
Shortcut:

Keyboard: Control+Q
Toolbar:    



Zoom Out
Use this command to minimize the data magnification and if possible, fit the whole sample in the data 
window.
Shortcut:

Keyboard: Control+W
Toolbar:    



Status Format
Use this command to specify whether the status bar displays sample lengths and selection points in 
terms of number of samples, time in seconds, or frames.

Samples Status values are displayed in terms of the number of samples.
Shortcut:
Toolbar:    

Time Status values are displayed in terms of seconds and fractions there of.
Shortcut:
Toolbar:    

FramesStatus values are displayed in terms of frames and fractions there of.
Shortcut:
Toolbar:    

SMPTE Status values are displayed in terms of seconds and frames.
Shortcut:

Toolbar:    



The Window Menu

Cascade
Use this command to arrange the data windows so they overlap with the title bar of each window 
remaining visible.

Tile Horizontally
Use this command to arrange the data windows side by side without them overlapping.

Tile Vertically
Use this command to arrange the data windows top to bottom without them overlapping.

Arrange Icons
Use this command to arrange the minimized data icons in the Factory workspace.

Minimize All
Use this command to minimize all open data windows in the Factory workspace.

Close All
Use this command to close all open data windows in the Factory workspace.



The Play Bar
The play bar consists of 5 buttons and five status fields.    The buttons control play, record, stop, rewind, 
and fast foward.    The status fields show a variety of status information as well as allowing editing of the 
rate, channels, and bit size of a data file.

Play Button
Record Button
Stop Button
Rewind Button
Fast Forward Button



Play
The Play button will play the selected section of the sample in the current sample data window.    If no 
selection is currently active then the full sample will be played. 

Note: If the Loop Sample option is turned on Kaboom! Factory will continuously repeat playing the 
sample selection until the Stop Button is pressed.
Shortcut:

Keyboard: Control+P

Info!
When playing stereo files, if a selection is made with only the left or right channel only the selected 
channel is played.    This allows you to hear individual channels of a stereo file.

Once a selection is made you can toggle the selection between left, right, and both by using the TAB key.



Record
The Record button is used to record into an existing data window or to record a completely new data 
window.    If no data windows are currently open or you hold the Control key while pressing the 
Record button recording to a new window is selected.      If a data window is open the default 
operation is to record into the selected window starting at the current insertion point.

When recording to a new window you will be prompted with a dialog box which allows you to adjust 
rate, bits per sample, and channels.    You can also check the level of your recording source.

When recording to an existing window you will be prompted with a dialog box which allows you to 
check the level of your recording source.

To check your levels press the check button.    The meters will now light up related to the volume of 
the recording input.    For best results the level should be somewhere in the yellow range.    Once your
levels are checked you can immediately begin recording by pressing the OK button or cancel 
recording with the Cancel button.

While you are recording a percentage meter appears on the main control bar.    As your hard drive fills
up with recorded data so does the percentage bar.    This will give you an indicator of how much 
space you have left during recording.    If the Enable Record Counter option in the Status Options 
dialog is enabled, Kaboom! Factory will also update the file size on the play bar while recording.



When you have finished recording press the Stop Button to end the record session and display the 
recorded data.

Modifiers:

Holding down the shift key while selecting the Record button will skip the dialog box and immediately 
begin recording into the currently selected data window..

Holding down the control key while selecting the Record button will bring up the dialog box for 
recording into a new data window.

Holding down the shift and control keys while selecting the Record button will skip the dialog box and
begin recording immediately into a new data window with the previously selected Mono/Stereo, 8 
bit/16 bit, and Rate settings.

Shortcut:
Keyboard: Control+R



Stop
The Stop button will stop the current play or record action.    If the current action is record the 
recording session will end and the newly recorded data will be displayed in the new sample data 
window. 

Shortcut:
Keyboard: Escape



Rewind
The Rewind button will place the cursor in the current data window at the start of the data.

Shortcut:
Keyboard: Home



Fast Forward
The Fast Forward button will place the cursor in the current data window at the end of the data.

Shortcut:
Keyboard: End




